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Introduction 
 
Informatik Reformat Version 10 requires the Microsoft Framework version 2.0 or 
later. 
 
Informatik Reformat allows you to reformat most common graphics formats, both 
popular formats and old legacy formats, but excluding PDF.  The processing is 
done on single files, selected files, entire directories, even nested subfolders.  For 
PDF options, see PDF Options section below. 
 
The measurement standard is Inches or Centimeters.  The default is set by the 
International Windows version, but it can be changed in Setup. 
 
Options are: 
 
Change one graphics format to another graphics format, for example reformatting 
an old legacy format to a newer format. 
 

o Combine files into a multi-page TIFF file 
 

o Split a multi-page file into serialized single-page files. 
 

o Make metric changes to image files: 
 

• Resize the image, with or without change of the canvas size 

• Resize the canvas 

• Change resolutions 

• Shift the image in any direction 

• Crop a section of the image 

• Trim/Clear any of the four sides of the image 

• Rotate the image, including conditional rotation 

• Inversion 
 

o Make graphics changes 
 

• Add text annotations along any of the image sides, or centered, or 
anywhere, at your chose of font options and color. 

 

• Add watermark, solid color or outline (hollow characters) 
 

• Add image, opaque or transparent 
 
 
Informatik Reformat includes a separate non-integrated utility for converting Tiff 
files (and many other graphics formats) to PDF formats.  The utility can convert 
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individual files, a selection of files, entire folder, even nested sub-folders.  The 
utility can be accessed from the Informatik Reformat’s File menu. 
 

Performance 
 
For extremely fast performance of monochrome images, use black text and 
monochrome image inserts. 
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How to Use 
 

Step 1:  Select the files that you wish to reformat. 

 
If you wish to select only one or a few files from one directory, click on the ‘Select 
Individual Files(s) button.  Select the files.  To select several contiguous files, 
click on the first file, then click on the last file of the selection, all while holding 
down the SHIFT key.  To select several non-contiguous files, click on the files 
while holding down the CTRL key. 
 
To select all files in a folder, press the ‘Select All Files in Folder’ button.  The 
number of files is indicated in the Taskbar at the bottom of the window.  Please 
check and make sure that the Filter is set correctly, so that the right files are 
processed.  If you type in your own filter, you must press the Refresh button so 
that the files are re-filtered. 
 
If you also want all sub-folders to be included, check the ‘Include Nested 
Subfolders checkbox. 
 
Now, to review the files to be processed, click on the Review List of Files link, or 
click on the number of files display in the taskbar.  The Review List allows you to 
re-arrange the files, to add files, to remove files from the lineup, even to view 
files.  It is recommended that you always review the files before they are 
processed. 
 
 

Step 2:  Specify the Reformatting Options. 

 
This step is not needed if you simply want to convert from one graphics format to 
another graphics format. 
 
There are two types of reformatting options: 
 

o Metrics Options 
o Graphics Options 

 
Metrics Options include (each is covered in separate sections below): 
 

o Resize the image, with or without change of the canvas size 
o Resize the canvas 
o Change resolutions 
o Shift the image in any direction 
o Crop a section of the image 



 6 

o Trim/Clear any of the four sides of the image 
o Rotate the image, including conditional rotation 
o Inversion 

 
Graphics Options include (each is covered in separate sections below)  
 

o Add text annotations along any of the image sides, or centered, or 
anywhere, at your chose of font options and color. 

 
o Add watermark, solid color or outline (hollow characters) 

 
o Add image, opaque or transparent 

 
 
To clear the window, press the Reset button. 
 
Your settings can be saved and retrieved as templates via the File menu. 
 
 

Step 3:  Save the Files. 

 
Before you save the files, consider and set the output formats.  The following 
options are available: 
 

Graphics Format 

 
The most popular formats are listed: 
 

• Auto (normally uses format of source files) 

• TIFF (always use for multi-page files) 

• PNG (single-page files only, good compression) 

• GIF (single-page files only, good compression) 

• BMP (single-page files only, no compression, creates large files) 

• JPEG (single-page files only, good compression, always use for photo 
images) 

• Other (many more formats are available) 
 

 
For additional supported formats, click on ‘Other’.  Informatik Reformat can 
support over 50 formats but for some rare formats you will need additional filter 
files, available free from Technical Support.  All filters are not included in the 
original download in order to keep the program download file reasonably small. 
 
For TIFF files, you also need to specify the TIFF compression: 
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• Auto (normally uses compression of source file) 

• CCITT4 TIFF Group 4 (monochrome only) 

• CCITT3 TIFF Group 3 (monochrome only, now rarely used) 

• LZW (color or monochrome, newest format) 

• JPEG (this format has best compression, but only for photo images) 

• Uncompressed (large files, generally do not use) 
 

Also, for TIFF files you can specify special attributes (advanced use only): 
 

• TIFF Fillorder/LSB 

• TIFF Multistrip 
 
 

Color Depth 

 

• Auto  (normally uses the color depth of the source files) 

• Black and White (monochrome, creates the smallest file footprint) 

• 16 Colors (dithers the image to 16 base colors, not recommended) 

• 256 Colors (dithers the image to 256 base colors) 

• True Color (full colors, but creates large files) 
 
Not all color depths are supported by all formats.  For example, JPEG-
compressed TIFFs save the 256-color images as grayscale, and there are other 
exceptions.  Always review the output before you run conversions. 
 

Page Ranges 

 
By default, all pages will be effected.  To effect only some pages, enter one or 
more page numbers or page ranges, for example: 1,5-6,10.  Sub-ranges must be 
in ascending order.  You can use a question mark for an unknown last page.  
Alternatively, you can check the EXCEPT checkbox and enter the pages or page 
ranges that you wish to exclude. 
 
If some pages need to be changed by metrics of graphics options, you are 
prompted as to whether you want to save all pages or only the changed pages.  
 
Note, this option cannot be used to re-arrange the page order.  Pages are always 
processed in the page order of the soruce file.  To re-arrange pages, you may 
want to use the Informatik TiffAppend or the Informatik Pagination programs 
(user-interactive programs). 
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File Extension Names 

 
If a specific graphics format is specified the default output file extesnion will 
generally be the standard extesnion for that format.  If ‘Auto’ format is selected, 
the output file will generally inherit the extension of the source file.  The option is 
effective only for the Convert function. 
 
You have the option to specify a particular extesnion name.  Check the 
‘Extension Prompt’ checkbox and the system will display a prompt where you can 
specify: 
 

• Default 

• Use Extesnion from Source File 

• Custom Extension  You speciy any extension. Type an extension with or 
without a dot; the system will take care of the syntax. 

 

Other... 

  
whether you want to be warned if an output file already exists, 
whether the source file should be deleted after processing,  
whether you want all errors to be posted to an error log. 
 
 
Before you save the files, click on the Review button.  The first page of the first 
image will be displayed.  Review the image and review file properties shown in 
the taskbar (bottom of the window). 
 
You are now ready to save the output files.  Select from one of the following 
options (buttons): 
 

Convert 

 
Choose this option if each input must be saved as one output file, no combining 
or splitting. 
 
If you are processing only one file, a Save As dialog is displayed.  Select the 
output file name and click on the Save Button. 
 
If you are processing several files, ‘the ‘Browse for Folder’ dialog is displayed.  
Select the output folder.  The output file name s will be taken from the source file 
names. 
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Convert/Combine 

 
Choose this option if all selected files must be combined into one output file. 
 
There are two methods: 
 

o Single Output File: Save all the files into one new file.  A prompt will ask 
you for the file name.  If nested sub-folders are processed, a combined file 
is created for each subfolder. 

 
o Batch – Multiple Output Files: Combine the files by batch into more than 

one file.  The files will be grouped by matching leading characters of the 
source files.  A prompt will ask you for the matching file name pattern.  An An An An 
overwrite alert is given only for the first fileoverwrite alert is given only for the first fileoverwrite alert is given only for the first fileoverwrite alert is given only for the first file.  If nested sub-folders are 
processed, each subfolder is handled separately.   

 
 

Convert/Split 

 

Choose this option if the pages of the input file(s) must be split into individual 
serialized files. 
 
If you are processing only one file, a dialog is displayed where you select the 
output file name.  Specify the numeric suffix (starting number and optional 
separator).  Make sure that you allocate sufficient zeros to cover the number of 
pages.  Click on OK button. 
 
If you are processing several files, a dialog is displayed where you select the 
output folder.  The output file name s will be taken from the source file names.  
Specify the numeric suffix (starting number and optional separator).  Make sure 
that you allocate sufficient zeros to cover the number of pages.  Click on OK 
button. 
 
 
After you have saved the files, you may want to review all or some of the 
converted files.  From the File menu, choose “Open ‘Last Saved’ Folder” to open 
the Windows Explorer with the listing of the newly saved file(s). 
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Options 
 

Image Size 

 
Width and height of the image can be changed, with or without changing the 
canvas (the overall size of the background).  Choose the metrics of the resize 
specification:  Inches/Centimeters, pixels, percentage, add/deduct.   Enter either 
the width or height, or both.  If you specify only one dimension, check or uncheck 
the ‘Constrain Proportions”.  You can change the size of the image inside a fixed 
canvas size, or you can change both the image and the canvas.  Furthermore, 
the system can reflect the new resolution (pixels-per-Inch). 
 
 

Canvas Size 

 
The canvas is the overall size of the image background.  The canvas size can be 
increased or decreased without changing the size of the internal image.  If you 
increase the canvas, the white border (left and bottom) will increase, but the 
image will remain unchanged. If you reduce the size of the canvas, some of the 
image may be truncated.  The new size of the canvas is specified in Inches or 
Centimeters.  You can change either the width or the height, or both. 
 
 
 

Resolution 

 
The resolution is the number of pixels per Inch.  There is a horizontal and a 
vertical resolution.  Generally, both resolutions are the same, but not always.  
The Resolution option allows you toe change either or both of the resolutions.  If 
you increase the resolution, the image will be displayed smaller (more pixels will 
be compressed into one Inch when the image is displayed, and vice versa.  If you 
check the ‘Resample Image’ checkbox, the pixels will be added or removed so 
that the new image will display at the original size. 
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Shift Image 

 
The inside image (the image on the canvas) can be shifted in any direction.  For 
example, you may want to shift the image up a bit in order to create white space 
at the bottom.  The shift values are entered in Inches or Centimeters.  Minus 
values move the image up or left; positive values shift the image right or down. 
 
 

Crop Image 

 
A rectangle of the image can be cropped.  Specify the crop starting point (upper-
left corner of the crop rectangle) and the width and height of the crop rectangle.  
The specifications are entered in Inches or Centimeters. 
 
Optionally, the cropped rectangle can be placed back centered on a blank canvas 
that is of the original size. 
 
 

Whiteout Rims 

 
The White Rims option allows you to blank out a slice if any of the four sides.  For 
example, you may have inserted an annotation at the bottom of the image.  The 
Whiteout Rims allows you to blank out a bottom strip.  The specifications are 
entered in Inches or Centimeters. 
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Rotation  

 
The image can be rotated at any right angle (90,270,180 degrees).  Also 
available are options that rotate the image conditionally, for example, only rotate 
if the image is landscape, or vice versa. 
 

Inversion 

 
The inversion option renders the image negative, ie. White becomes black and 
black becomes white. 
 

Flip/Mirroring 

 
The Flip option flips the image horizontally.  You may want to combine this option 
with a rotation to obtain a vertical flip. 
 

Byte Parity 

 
If Byte Parity is checked, the pixel count of the output file (horizontal and vertical) 
will be of a value that is divisible by 8. 
 
 

Annotations 

 
Text annotations can be made anywhere on the page.  The dropdown list shows 
the fixed locations of the annotations.  There are 13 fixed positions; 3 on each 
side of the image, horizontal at the top and bottom, vertical on the left and right 
sides. Each of the sides allows alignments for left, centered and right.  
Furthermore there is an option for centering and custom locations. 
 
If you specify a custom placement, specify the left and top of the desired 
annotation location.  Check the ‘From Right Border’ or ‘From Bottom Border’ 
check boxes if the placement specification is in reference to the right or bottom 
border (for example 1.5 inches from the right border). 
 
Click on the Font button to select the size, font name and attributes (bold, 
underline, etc).  The default font size is 8.  Click on the Color button to select a 
color.  The default color is black.  Color annotations to black and white source 
files create very large files 24-bit files, so select color only if needed.  You can 
specify 8-bit (256 color) file output to reduce the output file somewhat. 
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The annotations will be abutted tightly to the side of the image.  If you need to 
add some lateral space, use the Lateral Padding option. 
 
The text of the annotation can be entered or you can retrieve the text from a text 
file.  It is suggested that you place often-used annotation text files in the 
c:\Program Files\Informatik Inc\Informatik Reformat\Annotations folder.    
 
The text allows an extensive array of placeholders: 
 
� [+001] Auto-incrementing starting number (001 is just an example) * 
� [F]  File name (base name only) 
� [FF] File name (base name and extension name] 
� [FFF] File name (including full path) 
� [D]  Current date (short format as per Windows setting) 
�  [P]  Page number of source document 
� [PP] Number of pages of source document 
 
[F], [FF] and [FFF] will print the file names in capital letters.  To print lower-case 
characters use [f], [ff] and [fff] instead. 
 
* If you want the numbering to reset to base for each file, add an asterisk, for 
example [+0001*] 

 
Example: 
 
Some Text [FF] Page [P] of [PP] XYZ[+0001] 

 
would print as (for example):  
Some Text SOMEFILE.TIF Page 1 of 12  XYZ0001 
 
When batch processing, make sure that all files have a consistent resolution. 
 
For fastest conversion, use black text. 
 
 

Watermarks 

 
Watermarks can be placed centered, upper section or lower section.  There are 
two styles of watermarks:  Solid letters, or Outline letters (hollow letters).  If the 
watermark is too small, check the ‘Large Size’ checkbox. 
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Insert Image 

 
Image files can be inserted.  Click on the Browse button and select the image file.  
It is suggested that you place often-used image insert files in the c:\Program 
Files\Informatik Inc\Informatik Reformat\Images folder.   Specify the placement of 
the image in Inches or Centimeters.  Check the ‘From Right Border’ or ‘From 
Bottom Border’ check boxes if the placement specification is in reference to the 
right or bottom border (for example 1.5 inches from the right border).  
 
By default, the image will be inserted opaque.  If the image should be inserted 
semi transparent, specify the Transparency in the drop-down list.  Also specify 
the size of the insert image if not at the original 100%.  Inserted color images will 
create large 24-bit output files.  To reduce the output size somewhat, you may 
want to specify 8-bit (256 color).   
 
For black and white inserts you can specify that the white background be 
rendered transparent. 
 
For fastest conversion, use monochrome images. 
 
 
 

Order of processing 

 
The options are executed in the following order.   
 
Inversion 
Flip/Mirroring 
Rotation 
Cleanup Rims 
Crop 
Resize 
Canvas 
Shift 
Resolution 
Insert Image 
Text Annotation 
Watermarks 
 
 

PDF Options 
 
Informatik Reformat includes a separate (non-integrated) utility for converting Tiff 
files (and many other graphics formats) to PDF formats.  The utility can convert 
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individual files, a selection of files, entire folder, even nested sub-folders.  The 
utility can be accessed from the Options menu. 
 
The utility includes a separate Help file. 
 
 

TIFF Information 
 
Informatik Reformat includes a separate (non-integrated) utility for extract image 
properties from graphics files (batch procession of files in folders, subfolders).  
The properties include width, height, color depth, format/compression, 
resolutions.  The details are compiled in a tab-delimited text file. The utility can be 
accessed from the Options menu. 
 
 

Append TIFF Files, Pagination 
 
Informatik Reformat includes a separate (non-integrated) utility for appending Tiff 
files and rearranging or deleting pages of Tiff files. The utility can be accessed 
from the Options menu. 
 
The utility includes a separate Help file. 
 
. 
 

Technical Support 
 
For technical support contact information, please go to www.informatik.com 
 
 
 

License, Warranty, Disclaimer  
 
Please read the terms carefully before installing and using the software, as such 
conduct will indicate your acceptance of all of the terms of this license 
agreement.  If you do not agree with the terms, the software cannot be licensed 
to you and you must un-install and return the software to Informatik Inc, or its 
supplier or distributor. 
 
This License Agreement is a legal agreement between Informatik Inc. 
("Licensor"), a Delaware Corporation, and you, the user ("Licensee"), and is 
effective the date Licensee installs the software. 
 
This Agreement covers all materials associated with the Informatik Reformat 
software, including, without limitation, the downloadable software product, online 
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documentation, and any additional supporting electronic files (herein, the 
"Software"). 
 
The evaluation version may be used for 30 days after installation.  It is unlawful to 
use the software after the 30 day evaluation period without licensing the software 
and paying the license fees.  If a license is not obtained before the expiration of 
the 30 day evaluation period, the Software must be un-installed and destroyed. 
 
1. GRANT OF LICENSE 
Licensor hereby grants to you, and you accept, a nonexclusive license to use the 
Software according to the following condition: 
 
You may use the Software on one (1) computer (PC or workstation, excluding 
servers) owned, leased, or otherwise controlled by you for personal or business 
purposes, and only as authorized in this License Agreement.  The Software may 
not be used on other computers, nor may it be used by, or transferred to, other 
computers over a network.  The program may not be installed on a web server. 
 
2. LICENSOR'S RIGHTS 
Licensee acknowledges and agrees that the Software is proprietary to Licensor 
and protected under international copyright law. Licensee further acknowledges 
and agrees that all right, title, and interests in and to the Software, including 
associated intellectual property rights, are and shall remain with Licensor. The 
License Agreement does not convey to Licensee an interest in or to the Software, 
but only a limited right of use that may be revoked in accordance with the terms 
of this License Agreement. 
 
3. OTHER RESTRICTIONS 
This License Agreement strictly forbids distribution of the Software with 
Licensee's application. Distribution of the Software with Licensee's application 
requires separate authorization and the payment of license fees. 
  
Licensee agrees to make no more than one (1) back-up copy of the Software. 
Licensee agrees not to assign, sublicense, transfer, pledge, lease, rent, or share 
the rights assigned under this License Agreement. Licensee agrees not to 
reverse assemble, reverse compile, or otherwise translate the Software. 
 
4. TERM 
This License Agreement is effective when Licensee installs the Software and 
shall terminate only if the terms of this License Agreement are broken. Licensee 
agrees to destroy the Software upon termination of this License Agreement. 
 
5. NO WARRANTY; LIMITATION OF LIABILITY 
LICENSEE ACKNOWLEDGES THAT THE PROGRAM IS PROVIDED ON AN 
"AS IS" BASIS WITHOUT WARRANTY OF ANY KIND. LICENSOR MAKES NO 
REPRESENTATIONS OR WARRANTIES REGARDING THE USE OR 
PERFORMANCE OF THE SOFTWARE. LICENSOR incl. DEVELOPER, 
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COPYRIGHTHOLDER, DISTRIBUTOR) EXPRESSLY DISCLAIMS THE 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. LICENSOR SHALL HAVE NO LIABILITY TO LICENSEE OR ANY 
THIRD PARTY FOR ANY LOSS OR DAMAGE CAUSED, DIRECTLY  
OR INDIRECTLY, BY THE SOFTWARE, INCLUDING, BUT NOT LIMITED TO, 
ANY INTERRUPTION OF SERVICES, LOSS OF BUSINESS, LOSS OF DATA 
OR SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES. 
 
6. GOVERNING LAW 
This License Agreement shall be construed and governed in accordance with the 
laws of Pennsylvania.  
 
7. SEVERABILITY 
Should any court of competent jurisdiction declare any term of this License 
Agreement void or unenforceable, such declaration will have no effect on the 
remaining terms hereof. 
 
8. NO WAIVER 
The failure of either party to enforce any rights granted hereunder or to take 
action against the other party in the event of any breach hereunder shall not be 
deemed a waiver by that party as to subsequent enforcement of rights or 
subsequent actions in the event of future breaches. 
 
 
 

Copyright and Trademarks 
 
Copyright 2000-2008 Informatik Inc and J Buchmann.  All Rights Reserved. 
 
This application was developed using LEADTOOLS, copyright © 1991-2008 
LEAD Technologies, Inc. ALL Rights Reserved. 
 
 


